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1 The Approach behind DynamicSpotter

DynamicSpotter is a framework for automatic detection of performance problems in Java-based enter-
prise software systems. Therefore, DynamicSpotter combines the concepts of software performance
anti-patterns with systematic experimentation.

Software performance anti-patterns (SPAs) [SW00, SW02, SW03a, SW03b] describe common,
recurring design or implementation mistakes leading to impaired software performance. As a big
portion of software performance problems exhibit recurring nature, the concept of SPAs is a means
to identify such problems in different contexts (different target-systems, environments, etc.) by
searching for the generic patterns, or characteristics, different SPAs exhibit.

If the system under test (SUT) is implemented and can be executed, performance tests allow
to gain insights on its performance behaviour. There are three important things to know about
performance tests:

1. Usually, a load driver (such as JMeterTM[Apa14] or HP LoadRunner [Hew14]) is used to
generate a set of virtual users processing a script, which describes the work of single users.

2. During load generation, performance metrics are retrieved from the SUT using instrumentation
and monitoring techniques.

3. The gathered measurement data is analyzed to provide insights on particular performance
engineering tasks.

In our context, the gathered measurement data can be mapped to the generic characteristics defined
by individual SPAs. If measurement data matches certain pattern of an SPA, there is a high
chance that the SUT contains the corresponding anti-pattern. However, the following circumstances
render the detection of different SPAs with a single performance test impractical. Different SPAs
refer to different parts, performance metrics and granularity levels of the SUT. Thus, in order to
investigate different SPAs in a SUT as part of a single performance test, detailed and excessive
instrumentation of the SUT is required. However, as each instrumentation instruction comes with a
performance overhead, excessive instrumentation yields a high overhead which distorts measurement
data, rendering analysis on this data useless. Hence, an experiment-based process is needed in
which individual SPAs are investigated as part of individual performance tests (in the following
called experiments). In this way, during each experiment the SUT is instrumented selectively for the
corresponding SPA, providing detailed measurement data while keeping the performance overhead
of the instrumentation low.

Though, the experiment-based process significantly mitigates the problem of the performance
overhead introduced by the instrumentation, it increases the manual effort required to configure,
execute and analyze each single experiment referring to an SPA. Moreover, the larger the set of
investigated SPAs the more experiments are required, and with that the time required to execute
the experiments grows. However, this problem can be mitigated by using an appropriate structure
of the SPAs. Though there is a large set of different recurring performance problems, many of
those problems share common characteristics and symptoms. Hence, performance problems can
be structured in a systematic way, yielding a hierarchy from high level symptoms to specific root
causes of the problems. An example of such a hierarchy is depicted in Figure 1(a).

Varying Response Times is a symptom. The Ramp [SW03b] and Traffic Jam [SW02] are
potential causes of Varying Response Times. The Ramp occurs if response times of an application
increase during operation. Such a behaviour can, for example, occur if the application contains
Dormant References [RM07], i.e., the memory consumption of the application is growing over time.
The root cause is Specific Data Structures which are growing during operation or which are not
properly disposed. The Traffic Jam performance antipattern constitutes another cause of Varying
Response Times. A Traffic Jam occurs if many concurrent threads or processes are waiting for the
same passive resource ((like semaphores or mutexes)) or active resource (like CPU or hard disk).
In the first case, we have a typical One Lane Bridge [SW00] whose critical resource needs to be
identified. We focus on Synchronization Points, Database Locks, and Pools as potential root causes.
In the case of limited physical resources, the root cause can only be a specific Bottleneck Resource.
Further examples on a performance problem hierarchy can be found in [WHH13, WOHF14, Wer13].
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(b) Overview on the DynamicSpotter approach (graphic from [WOHF14])

Figure 1: DynamicSpotter approach

A hierarchy as depicted in Figure 1(a) can be utilized as a search tree, in order to systematically
search for performance problems by conducting a depth-first search on the tree. In particular, a
branch or sub-tree of the hierarchy does not need to be investigated if the problem corresponding
to the sub-tree’s root node is not present in the SUT. In our example, possible root causes for The
Ramp do not need to be investigated if The Ramp itself has not been detected in the SUT. In this
way, many unnecessary experiments can be avoided, saving experimentation time and effort.

DynamicSpotter utilizes the concept of hierarchically structuring performance problems (re-
spectively SPAs) in order to automate the search for recurring performance problems (SPAs) by
systematically executing measurement experiments. The high level approach behind DynamicSpot-
ter is depicted in Figure 1(b). DynamicSpotter takes a performance problem hierarchy (as described
before) as input. For each node of that hierarchy, performance experts define a heuristic responsible
to decide on the existence of the corresponding problem. To this end, a heuristic executes a series
of experiments, observes certain performance metrics and analyzes them to make a decision. (Note:
Both, the hierarchy and the corresponding heuristics are generic artifacts which do not depend on
the SUT under test and, thus, can be reused in other contexts.) For instance, in order to detect
a One Lane Bridge, the corresponding heuristic may execute a set of experiments with different
load intensities, while observing end-to-end response times. If response times significantly increase
with the load, while none of the hardware resources is utilized to capacity, the SUT contains an
OLB. For execution of experiments, a load script (workload description) specifies the work of single
virtual users. Traversing the hierarchy and applying corresponding heuristics for each performance
problem of the hierarchy, DynamicSpotter generates a detection result report. The report states
for each node in the hierarchy whether the corresponding problem exists in the SUT and, where
appropriate, points to the root cause and location in the SUT of a detected problem.
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2 Architecture of DynamicSpotter

As described in Section 1, DynamicSpotter is a framework for automatic detection of performance
problems. The architecture of DynamicSpotter is depicted in Figure 2. The main component of Dy-
namicSpotter (DynamicSpotter Core) realizes the logic for automating performance tests and data
analysis. In particular, DynamicSpotter Core is responsible for coordinating the instrumentation
of the system under test (SUT), the monitoring process, gathering and pre-processing measurement
data, as well as analyzing data. Furthermore, DynamicSpotter Core implements the high level
process of iterating a performance problem hierarchy (cf. Component Process Controller in
Figure 2), as described in Section 1. The Experiment Execution component is responsible for
automating experiment execution, while the Data Analysis component conducts the data analysis
task for individual performance problems according to the detection rules defined for corresponding
performance problems in form of Heuristics. For each sub-task, DynamicSpotter provides extension
points (denoted with �EP� in Figure 2) allowing to provide adapters for specific implementations
or tools used for instrumentation, monitoring, workload generation, and data analysis:

• �EP� Load Driver Adapter: The Load Driver Adapter extension point provides means
to use existing load driver tools like JMeter, Faban or HP LoadRunner for workload generation.
In particular, a Load Driver Adapter needs to provide means to control the execution of per-
formance tests programmatically. Furthermore, the adapter realizes a remote communication
between DynamicSpotter and the remotely running load generation tool.

• �EP� Instrumentation Adapter: The Instrumentation Adapter extension point al-
lows to provide adapters for instrumentation tools like DiSL, Kieker, our own instrumentation
tool AIM (Adaptable Instrumentation and Monitoring), etc. Thereby, DynamicSpotter uses a
generic instrumentation description model (IDM) to decouple the instrumentation description
from the tool realizing it. Thus, an instrumentation adapter for a specific instrumentation tool
has to realize the transformation from the IDM instances to the tool-specific representation of
the instrumentation description.

• �EP�Measurement Adapter: While an instrumentation adapter is solely responsible for
instrumenting the SUT, a Measurement Adapter is used to enable and disable data collection,
as well as to transform and transfer data from the monitoring tool to DynamicSpotter in
a common data representation format. Though a specific instrumentation adapter and a
measurement adapter are often realized within one external tool, they represent conceptually
different tasks. In such a case, adapters for both extensions points are required, even if only
one tool realizes both tasks.

• �EP� Detection Heuristic: As described in Section 1, DynamicSpotter uses a perfor-
mance problem hierarchy and corresponding heuristics to guide the detection process. Both
artifacts need to be provided by performance experts. For each performance problem defined
in the hierarchy, a performance expert can provide a Detection Heuristic extension which
is then responsible to define the experiments and analyse the corresponding measurement
data for the corresponding performance problem.

Depending on the size of the SUT, DynamicSpotter may use several Instrumentation Adapters,
Measurement Adapters and Load Driver Adapters. A set of adapters to be used in a specific ap-
plication context of DynamicSpotter determines the Measurement Environment for DynamicSpotter
. In order to use DynamicSpotter , a user has to specify the Measurement Environment in a config-

uration. Thereby, a user either can start a headless DynamicSpotter process (cf. DynamicSpotter
Runner in Figure 2) providing the configuration as input, or, the user harnesses the DynamicSpot-
ter Eclipse-Plugin to build a DynamicSpotter configuration in an interactive way, trigger
the automatic detection process, and finally, examine the detection results in the graphical user
interface. The DynamicSpotter Eclipse-Plugin communicates with a DynamicSpotter Service

layer running on top of the DynamicSpotter Core. Utilizing the description of the Measurement
Environment, DynamicSpotter identifies required extensions and establishes connections to the
corresponding external instrumentation, measurement and load generation tools. DynamicSpotter
is then able to automatically run performance tests and analyze measurement data as defined in
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the heuristics of the individual performance problems from the performance problem hierarchy. As
a result, DynamicSpotter provides a report to the user stating which performance problems have
been detected.
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Figure 2: DynamicSpotter architecture
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3 DynamicSpotter - Quick Start

To get a demo for DynamicSpotter running, follow the following steps.
Note: The following screenshots show the execution in Windows and work similarly in Linux.

1. First, you need a Java JDK 1.7 to be installed.

2. Download the Demo-Bundle from the following URLs:

Windows: https://github.com/sopeco/DynamicSpotter-Demo/releases/download/v1.0/demo-
all-in-one.zip
Linux: https://github.com/sopeco/DynamicSpotter-Demo/releases/download/v1.0/demo-all-
in-one.tar.gz

3. Unpack the archive to an arbitrary directory. Lets call it DEMO_HOME:

4. Open a command line window (e.g. cmd in Windows) and go to the DEMO_HOME directory with
cd PATH_TO_DEMO_HOME.
Linux only: make the script files executable with: chmod u+x ./*.sh

5. Start the target application (System under Test) by executing the following command line
script:

Windows: startDemoApp.bat

Linux: sh ./startDemoApp.sh

If you see a line ending with
...- Web-Server started on port 8081

the target application has been started successfully:

IMPORTANT: Do not stop the application!

6. Open a second command line window and again go to the DEMO_HOME directory

7. Start DynamicSpotter analysis by executing the following command line script:

Windows: startDSfromCommandLine.bat

Linux: sh ./startDSfromCommandLine.sh

If DynamicSpotter has been started successfully you should see progress report in the command
line:

8. In the demo scenario DynamicSpotter runs about 15 minutes to execute all required experi-
ments and analyze the measurement data.
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9. When DynamicSpotter has finished its analysis it generates a result report in the DEMO_HOME/results
directory. There DynamicSpotter creates a folder with the latest timestamp as folder name.
Go to that directory.

10. The SpotterReport.txt file contains a textual description of which problems have been
detected or not.

11. If you further go to the individual directories of the anti-patterns (e.g. OLB 2006070899),
there you find the raw measurement data in the csv folder and (if available) some graphs in
the result-details folder illustrating the problem:
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The following graphs for instance show that the response times of the testOLB() service grow
with the load, while the CPU utilization stays low.

Please read the next chapter to get more details on the Demo scenario and to see how to
configure DynamicSpotter using an Eclipse plugin.
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4 DynamicSpotter - Getting Started

In this section, we demonstrate the usage of DynamicSpotter on a very simple scenario. Some of the
DynamicSpotter plugins we use in this scenario are just simple examples (e.g. the plugin for load
generation) to demonstrate the DynamicSpotter framework. In real scenarios more sophisticated
DynamicSpotter plugins would be used, such as the JMeter plugin for load generation.

We show how to configure the target application, set-up DynamicSpotter , run DynamicSpotter
diagnosis and view diagnosis results.

4.1 Requirements

In order to run through the demo example in this section, the following is required:

• JDK (tested with JDK 1.7)
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html

• An Eclipse standard installation (tested with Eclipse Kepler)
http://www.eclipse.org/downloads/packages/eclipse-standard-432/keplersr2

4.2 All-In-One Demo Example

All binaries required for executing the demo scenario are available in the All-In-One archive which
you can download from the following URLs:

Windows: https://github.com/sopeco/DynamicSpotter-Demo/releases/download/v1.0/demo-all-
in-one.zip
Linux: https://github.com/sopeco/DynamicSpotter-Demo/releases/download/v1.0/demo-all-in-
one.tar.gz

Unpack the archive in any directory. The content of the archive is the following:
/

demo-app.jar

instrumentation-agent.jar

ds-server.jar

plugins

instrumentation-plugin.jar

measurement-plugin.jar

loadgeneration-plugin.jar

detection-olb-plugin.jar

detection-ramp-plugin.jar

ds-eclipse-ui.jar

loadScript

org

spotter

ext

demo

load

VUser.class

ds-cl-runner.jar

demo-config

hierarchy.xml

mEnv.xml

spotter.conf

The demo-app.jar comprises the target demo application used in the following scenario as
the system under test (SUT). In order to be able to retrieve some performance data from the
target application, we provide an instrumentation-agent.jar which allows to instrument the
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target application and gather measurement data. Thereby, instrumentation-agent.jar con-
tains the Java-agent from our own instrumentation tool AIM (adaptable instrumentation and
monitoring) also available on GitHub (cf. Section 7). The instrumentation agent needs to be
started with the target application as an additional JVM parameter, which we will explain later
in more detail. The DynamicSpotter framework is bundled in the ds-server.jar. The plugins

directory contains a set of extensions for DynamicSpotter which we need for this demo scenario.
In particular (according to the architecture described in Section 2), we need an instrumentation
(instrumentation-plugin.jar) and measurement adapter (measurement-plugin.jar) to connect
to the instrumentation agent, a load generation plugin (loadgeneration-plugin.jar) to be able to
submit load on the target application, and some detection heuristics (detection-olb-plugin.jar
and detection-ramp-plugin.jar ) for the analysis of certain performance problems. For sim-
plicity, in this scenario we use only two detection heuristics, one for detecting a One Lane Bridge
anti-pattern (software bottleneck) and a heuristic for the detection of the Ramp anti-pattern (slowly
decreasing software performance). The ds-eclipse-ui.jar is a plugin for Eclipse comprising
the graphical user interface for DynamicSpotter . Finally, the loadScript directory contains a
load scenario for the target application in form of a Java class (including the package-directory
structure). In order to run DynamicSpotter in a batch mode from the command line one can use
the ds-cl-runner.jar. The demo-config folder contains demo configuration for the execution of
DynamicSpotter from command line.

4.3 Demo Application

For our demonstration scenario we use a dummy application providing two services. A service
containing a One Lane Bridge (OLB) performance anti-pattern and a second service without any
performance problems. Listing 1 shows the code of the target dummy application. The DummyApp

class comes with two REST services: testOLB and fibonacci. The first service contains an OLB
anti-pattern manifested in a call to a synchronized method (OLB.olbMethod()) becoming a software
bottleneck. This dummy application runs on a Web server such that users of that application can
access the services via a REST interface.

Listing 1: Code of the Demo Application

pub l i c c l a s s DummyApp {
// A dummy s e r v i c e conta in ing a One Lane Bridge ant i−pattern
@GET @Path( ”testOLB ”)
pub l i c S t r ing testOLB ( )

throws Inter ruptedExcept ion {
System . out . p r i n t l n ( ”OLB c a l l e d ” ) ;
OLB. ge t In s tnace ( ) . olbMethod ( ) ;
r e turn ”He l lo from OLB Test Method ! ” ;

}

// Another dummy s e r v i c e conta in ing no performance problems .
@GET @Path( ” f i b o n a c c i ”)
pub l i c S t r ing f i b o n a c c i ( ) {

f i b o n a c c i ( 4 ) ;
r e turn ”He l lo from Fibonacc i Method ! ” ;

}

// Recurs ive c a l c u l a t i o n o f f i b o n a c c i .
p r i v a t e i n t f i b o n a c c i ( i n t n) {

i f (n <= 1)
return 1 ;

e l s e
re turn f i b o n a c c i (n − 2) + f i b o n a c c i (n − 1 ) ;

}
}
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pub l i c c l a s s OLB {
. . .
// Method l ead ing to a One Lane Bridge .
pub l i c synchron ized void olbMethod ( ) throws Inter ruptedExcept ion {

Thread . s l e e p ( 1 0 0 ) ; // s l e e p 100 ms
}

}

In order to execute the demo application execute the following command in the directory you
have unpacked the all-in-one archive to:

java −javaagent : instrumentat ion−agent . j a r − j a r demo−app . j a r s t a r t

With -jar demo-app.jar start we instruct the demo application to start. Additionally we provide
a -javaagent JVM argument pointing to the instrumentation-agent.jar. This Java agent is
later used to dynamically instrument the bytecode of the target application in order to retrieve
different types of measurement data. The Java agent starts a REST service on port 8888.

4.4 Load Script

As described in Section 2, for the performance tests executed by DynamicSpotter , a load script is
required which describes the behaviour of the target application users. Depending on the tool used
for load generation, the load script has a different representation. For instance, HP LoadRunner and
Apache JMeter each have proprietary representations of the load script. For the sake of simplicity, in
this demo scenario we use a very minimalistic load generator which repeatedly executes a Runnable
for each emulated user. Thus, the load script is defined by a Java class implementing a certain
interface. Listing 2 shows the load script we use in this demo scenario. It is the Java code the
org.spotter.ext.demo.load.VUser class which you can find in the loadScript directory of the
all-in-one drop.

Listing 2: Load Script

import java . u t i l . Random ;
import javax . ws . r s . core . MediaType ;

import org . lpe . common . u t i l . web . LpeWebUtils ;
import org . s p o t t e r . ext . workload . s imple . ISimpleVUser ;

import com . sun . j e r s e y . ap i . c l i e n t . C l i en t ;
import com . sun . j e r s e y . ap i . c l i e n t . WebResource ;

pub l i c c l a s s VUser implements ISimpleVUser {

p r i v a t e s t a t i c f i n a l i n t THINK TIME MIN = 100 ;
p r i v a t e s t a t i c f i n a l i n t THINK TIME MAX = 200 ;
p r i v a t e s t a t i c f i n a l Random random = new Random( System . nanoTime ( ) ) ;
p r i v a t e f i n a l WebResource webResource ;

pub l i c VUser ( ) {
Cl i en t c l i e n t = LpeWebUtils . getWebClient ( ) ;
webResource = c l i e n t . r e s ou r c e ( ”http :// l o c a l h o s t :8081/ ” ) ;

}

@Override
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pub l i c void e x e c u t e I t e r a t i o n ( ) {
t ry {

// c a l l OLB s e r v i c e
webResource . path ( ”demo” ) . path ( ”testOLB ” ) .

accept ( MediaType .APPLICATION JSON ) . get ( S t r ing . c l a s s ) ;

Thread . s l e e p ( getNextThinkTime ( ) ) ;

// c a l l F ibonacc i s e r v i c e
webResource . path ( ”demo” ) . path ( ” f i b o n a c c i ” ) .

accept ( MediaType .APPLICATION JSON ) . get ( S t r ing . c l a s s ) ;

Thread . s l e e p ( getNextThinkTime ( ) ) ;
} catch ( Throwable e ) {

// i g no r i ng except ion
e . pr intStackTrace ( ) ;

}
}

p r i v a t e long getNextThinkTime ( ) {
i n t r = random . nextInt (THINK TIME MAX − THINK TIME MIN ) ;
re turn THINK TIME MIN + r ;

}

}

Assuming a closed workload, the executeIteration() method of the VUser class defines the
actions of an emulated user in one iteration of the loop. In this particular example, the emulated
users first call the testOLB service of the Demo application and then call the fibonacci service.
Inbetween the actions, the users idle for a think time between 0.1 and 0.2 seconds. Later when
configuring DynamicSpotter , we will have to reference this class in order to specify the usage
behaviour submitted to the target application.

4.5 Using the DynamicSpotter Eclipse UI

DynamicSpotter can be executed either as a service allowing an Eclipse-Plugin to connect to the
DynamicSpotter service, or DynamicSpotter can be executed in a batch mode from the command
line. In this section we show how to use DynamicSpotter from the Eclipse UI.

Starting DynamicSpotter Service

As shown in Figure 2, the DynamicSpotter Eclipse-Plugin is decoupled from the core of Dynam-
icSpotter . The DynamicSpotter Eclipse-Plugin communicates with the DynamicSpotter Service
over a REST interface. Thus, in order to use DynamicSpotter with the Eclipse UI, first, we need to
start the DynamicSpotter Service. From the command line you can execute the following command
to start the DynamicSpotter Service (execute from the directory you unpacked the all-in-one drop
to):

java − j a r ds−s e r v e r . j a r s t a r t

This will start the DynamicSpotter Service on the default port 8080. In order to load all available
plugins, DynamicSpotter looks for a plugins folder in the directory you have executed Dynam-
icSpotter from. From that directory, DynamicSpotter dynamically loads all jars representing
DynamicSpotter extensions.

In order to use another port, or another root directory for the plugins folder, the following
program arguments can be used to specify the port and the root directory:

java − j a r ds−s e r v e r . j a r s t a r t port=<PORT> rootDir=<ROOT DIR>

12



Starting Eclipse with the DynamicSpotter Plugin

If you do not have an Eclipse installation yet, download and install Eclipse:

http://www.eclipse.org/downloads/packages/eclipse-standard-432/keplersr2

Drop the ds-eclipse-ui.jar into the plugins directory of your Eclipse installation and start
Eclipse. Under Window → Open Perspective → Other change to the perspective DynamicSpot-

ter (cf. Figure3).

Figure 3: Open DynamicSpotter perspective

Creating and Configuring a DynamicSpotter Project

The DynamicSpotter Eclipse-Plugin provides the notion of DynamicSpotter Project. A Dynam-
icSpotter Project covers the configuration, execution and results of DynamicSpotter for a specific
scenario (i.e. system under test). For our demo application scenario we first need to create a
DynamicSpotter Project. Therefore, select New → DynamicSpotter Project in the context menu
of DynamicSpotters’s Project Navigator (cf. Figure4(a)). In the project wizard, a name for the
project and the configuration of the connection to the DynamicSpotter Service are required (cf.
Figure 4(b)). The new project should appear in the Project Navigator (cf. Figure 5).

(a) Context Menu (b) DynamicSpotter Project Wizard

Figure 4: Creating DynamicSpotter Project
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Figure 5: Project Structure

A DynamicSpotter Project has two main nodes: a Configuration part and a Results part.
In the Configuration part, one has to specify the scenario-specific properties as well as domain
specific configuration parameters for DynamicSpotter . The DynamicSpotter Config contains
global configurations and domain specific information required for the execution of DynamicSpotter
on the specific system under test. The Satellite Adapter configurations allow to specify the
measurement environment of the scenario including configuration of instrumentation, measurement
and workload adapters. The Results part provides a history of results for DynamicSpotter diagnosis
runs executed for that DynamicSpotter Project.

In the following, we explain how to configure DynamicSpotter for our demo scenario. First,
we edit the DynamicSpotter Config by opening (double-click on DynamicSpotter Config in the
Project Navigator) the DynamicSpotter Config Editor (cf. Figure 6). We can edit the individual

Figure 6: DynamicSpotter Config Editor

properties like experiment duration, maximal expected number of users, etc. The tool tip on each
property shows the description of that property. DynamicSpotter requires six parameters specifying
the workload to be mandatory configured for a certain scenario (parameters starting with work-

load.*). Additionally to the mandatory properties, one can configure optional properties. Therefore,
add an optional property by clicking on the Add... button at the bottom right, and select a parame-
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ter you would like to edit. For our demo scenario we use a configuration as depicted in Figure 6: We
set the duration of the initial warm-up phase (prewarmup.duration) of the system under test to 10
seconds. Each experiment should be executed for 180 seconds (workload.experiment.duration),
and for the ramp-up and cool-down behaviour of each experiment we define a user entry rate of
that 5 users per second. Furthermore, we expect a maximum number of 100 users for our demo
scenario (workload.maxusers). Finally, we save that configuration.

As next step we specify the measurement environment. As you may remember, in Section 4.3
we started the demo application with an instrumentation agent. That agent covers the functionality
of two DynamicSpotter Satellite Adapter types: it is responsible for instrumenting the target
application (Instrumentation Satellite Adapter) and in order to retrieve the measurement
data generated by the instrumentation code that agent provides an interface for a Measurement

Satellite Adapter. Furthermore, besides that two adapters we will need to configure a Workload

Satellite Adapter using the load script described in Section 4.4.
We start with specifying the instrumentation adapter. Therefore, we need to open the editor

for Instrumentation Satellite Adapters. There, we add an instrumentation adapter of type
instrumentation.satellite.adapter.default( Add... button on the upper part of the editor).
We then see a instrumentation adapter entry in the list with a red cross (cf. Figure 7). The red

Figure 7: DynamicSpotter Instrumentation Satellite Adapter Editor

cross means that no connection to the satellite could be established. As mentioned in Section 4.3,
the instrumentation agent starts per default its REST service on port 8888. Thus, we need to
change the port in the properties view of the instrumentation adapter (satellite.port) from
8080 to 8888. This should turn the red cross to a green check mark. Again, we need to save
the configuration. Analogously to the configuration of the instrumentation adapter we have to
create a measurement adapter in the Measurement Satellite Adapter editor. Thereby, we need
a measurement adapter of type measurement.satellite.adapter.instrumentation in order to
connect to the measurement interface of the instrumentation agent.

Next, we have to configure a workload adapter. Therefore, we open the Workload Satellite

Adapter Editor and add a satellite of the type workload.satellite.adapter.customized (cf.
Figure 8). This type of workload adapter is a simple load generator which runs within the
DynamicSpotter process. Therefore, this adapter does not have properties like host or port and is
per default connected to DynamicSpotter (green check mark). The customized workload adapter
uses a Java class extending the interface ISimpleVUser (cf. Section 4.4) as a load script for
a virtual user. Thus, we need to specify the full qualified class name of that load script class
(workload.simple.userScriptClassName) and the path (workload.simple.userScriptPath) to
the directory containing the Java package structure (the loadScript directory of the all-in-one-drop
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Figure 8: Configuration of the Workload Adapter

archive).
Finally, we have to tell DynamicSpotter which performance anti-patterns should be analyzed in

the target application. Configuring the performance problem hierarchy is a task for performance
experts. Therefore, we first have to activate the expert view by selecting Enable Expert View

in the context menu of our DynamicSpotter Project (cf. Figure 9(a)). Now, an additional node

(a) Enabling Expert View (b) Hierarchy Editor

Figure 9: Editing the Performance Problem Hierarchy

called Hierarchy should appear in the project navigator. Double click on that node to edit the
performance problem hierarchy. For sake of simplicity, in our demo scenario we consider only two
performance anti-patterns to be analyzed: the One Lane Bridge (OLB) and the Ramp anti-pattern.
Add (flat, not appending) both anti-patterns to the hierarchy and save the changes (cf. Figure 9(b)).
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Having configured the global properties and specified the measurement environment, our
DynamicSpotter Project is ready to be executed. Therefore select the DemoApp project in the
DynamicSpotter Project Navigator and click on the Run button (or Run DynamicSpotter in the
context menu of the Project Navigator). In general, depending on the complexity of the scenario
the execution of DynamicSpotter may take hours. The execution of our demo scenario may take up
to 30 minutes.

Analyzing DynamicSpotter Results

The results of a run are stored in the project’s results folder. For each run a separate folder is
created. Inside this folder all relevant data of the run are stored, e.g. also additional resources that
were generated. Each of these folders are represented as a sub-node under the Results node in the
DynamicSpotter project navigator.

Figure 10: Show Results View

If the Results View has not been opened yet, it can be opened via Window → Show View →
Other... under the category DynamicSpotter (cf. Figure 10), or simply by double-clicking on any
of the results sub-nodes.

The Results View displays the content corresponding to the selected run node in the navigator
(cf. Figure 11). The view contains two tabs, one showing the hierarchy and one showing the report
text. In the upper part of the hierarchy tab there is the hierarchy tree that was used during the
diagnosis. Each detected problem is marked with a red flag. Problems that have not been detected
are marked with a green flag. An exclamation mark signals that there has been an error during the
diagnosis of this problem.

In the lower part the details of the currently selected problem including its related resources are
shown. If resources are available, clicking on one of the items in the list will show a little preview
next to it which can be enlarged by clicking on the preview image.

In our demo example, the Ramp anti-pattern has not been detected, however, DynamicSpotter
detected a One Lane Bridge (OLB) in method org.spotter.ext.demo.app.DummyApp.testOLB()

(cf. Figure 11). The additional resources (graphs) show that the response times grow steadily with
the load while the CPU utilization does not increase significantly.

4.6 Executing DynamicSpotter from Command Line

When using the Eclipse-Plugin to configure a DynamicSpotter Project, the Eclipse-Plugin creates
configuration files for DynamicSpotter in the background (which you can find in the project
directory in your Eclipse workspace). In order to execute DynamicSpotter from the command
line, DynamicSpotter configuration files need to be passed to DynamicSpotter directly instead of
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Figure 11: Results View

executing the steps from Section 4.5. First, adapt the paths in the demo-config/spotter.conf of
the all-in-one-drop. In particular, set the paths to the hierarchy XML, the measurement environment
XML and the result directory:

# path to the XML f i l e d e s c r i b i n g the problem h i e r a r c h y
org . s p o t t e r . conf . prob lemHierarchyFi le = . . .

# path to the XML f i l e d e s c r i b i n g a l l measurement s a t e l l i t e s
# and t h e i r c o n f i g u r a t i o n s
org . s p o t t e r . measurement . env i ronmentDesc r ip t i onF i l e = . . .

# path to the d i r e c t o r y c o n t a i n i n g the r e s u l t s
org . s p o t t e r . r e s u l t D i r = . . .

Furthermore, you need to adapt the path to the workload file in the demo-config/spotter.conf.
Therefore, for the property org.spotter.workload.simple.userScriptPath set the value to the
absolute path of the all-in-one-drop/loadScript directory.

. . .
<workloadAdapter>

<extensionName>workload . s a t e l l i t e . adapter . customized</extensionName>

<c o n f i g key=”org . s p o t t e r . s a t e l l i t e . adapter . name”
value=”Customized Workload S a t e l l i t e Adapter ”/>

<c o n f i g key=”org . s p o t t e r . workload . s imple . userScr iptClassName ”
value=”org . s p o t t e r . ext . demo . load . VUser ”/>

<c o n f i g key=”org . s p o t t e r . workload . s imple . use rScr iptPath ”
value=” . . . ”/>

</ workloadAdapter>
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. . .

Having adapted the configuration files use the following command to start DynamicSpotter from
the command line:

java − j a r ds−c l−runner . j a r <PATH TO SPOTTER CONF>

Thereby, the <PATH_TO_SPOTTER_CONF> points to the DynamicSpotter configuration as provided
with the all-in-one-drop (demo-config/spotter.conf). During execution, DynamicSpotter writes
the measurement and detection results to the specified result directory.
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5 Building DynamicSpotter

In order to build the DynamicSpotter framework, the following tools need to be installed:

• JDK (tested with JDK 1.7)
http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html

• Git client
http://git-scm.com/downloads

• Maven 3
http://maven.apache.org/download.cgi

In Section 7, we provide some useful Web links including the link to the DynamicSpotter frame-
work repository. Use a Git client to clone the repository from the DynamicSpotter GitHub repository:

https://github.com/sopeco/DynamicSpotter/tree/ver-1.0.0

The DynamicSpotter framework comprises seven sub-projects:

Project Name Description

org.spotter.parent Maven parent project for the DynamicSpotter framework

org.spotter.core Comprises the core of the DynamicSpotter framework

org.spotter.runner Wraps a command line executor around DynamicSpotter core

org.spotter.service Wraps a Web server around DynamicSpotter core extending it with a
REST service layer.

org.spotter.client The DynamicSpotter client is used to conveniently consume the
DynamicSpotter REST service from other applications using the
org.spotter.client library.

org.spotter.shared Comprises classes and artifacts shared between DynamicSpotter core,
DynamicSpotter runners and DynamicSpotter client

org.spotter.eclipse.ui The Eclipse-Plugin provides a graphical user interface for configuring,
executing DynamicSpotter and analyzing its detection results. This
project uses the DynamicSpotter client to communicate with the
DynamicSpotter REST service.

Table 1: DynamicSpotter Project Structure

In order to build dynamic spotter use the command line and switch to the org.spotter.parent

directory. There, execute the following Maven build command:

mvn c l ean i n s t a l l

If executed successfully, Maven creates in the target directories of the individual sub-projects
the corresponding JARs. The executable JAR for the DynamicSpotter Service is located in the
org.spotter.service/target directory.

The Eclipse Plugin JAR is located in the org.spotter.eclipse.ui/target directory.
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6 Writing Extensions for DynamicSpotter

As mentioned in Section 2, DynamicSpotter provides four different types of extensions which are
required to run DynamicSpotter . These types are explained in Section 2. A collection of some
extensions for DynamicSpotter is available under the following GitHub repository:

https://github.com/sopeco/DynamicSpotter-Extensions

In this section, we explain how to write different types of extensions for DynamicSpotter .

6.1 General Structure of a DynamicSpotter Extension

DynamicSpotter extensions can be either bundled in separate JARs or in aggregated JARs each
containing several extensions. A single extension at least comprises a Java class providing meta-
information about the extension (with typical suffix ___Extension), a Java class representing the
actual extension artifact, and an entry in a text file declaring the extension. The extension class
has to implement at least three methods (cf. Listing 3).

Listing 3: Methods to be implemented by an Extension Class

. . .

/∗∗
∗ Returns the name o f the extens i on which i s expected
∗ to be unique in the framework .
∗
∗ The name i s expected to be s p e c i f i c to the extens i on
∗ that i s provided .
∗/

St r ing getName ( ) ;

/∗∗
∗ Returns a s e t o f c o n f i g u r a t i o n parameter d e s c r i p t i o n s .
∗/

Set<Conf igParameterDescr ipt ion> getConf igParameters ( ) ;

/∗∗
∗ Creates a new a r t i f a c t f o r t h i s ex tens i on .
∗/

EA c r e a t e E x t e n s i o n A r t i f a c t ( ) ;

. . .

The getName method specifies the name of the extensions, the getConfigParameters method allows
to define a set of extension-specific configuration parameters, and the createExtensionsArtifacts
method creates the actual extension artifact. The extension artifact needs to pass an instance of
the extension class as the extension provider to the super constructor (cf. Listing 4).

Listing 4: A constructor of an Extension Artifact

/∗∗
∗ Constructor .
∗/

pub l i c ExtArt i f a c t ( IExtens ion<IDe t e c t i onCont ro l l e r> prov ide r ) {
super ( prov ide r ) ;

}
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Finally, we have to declare the extension in the extensions.info file. The extensions.info file
contains per extension a line with the full qualified name of the corresponding extension (provider)
class (cf. Listing 5).

Listing 5: Declaring an extension in the extensions.info file

. . .
f u l l . q u a l i f i e d . name . o f . Extens ionClass
. . .

The extensions.info file needs to be located in a directory called plugins. Assuming that we
bundle each extension in a separate JAR, despite for additional dependencies the JAR structure
would look like as follows:

/

org

...

MyExtension.class

MyExtensionArtifact.class

plugins

extensions.info

In the following, we describe for each extension type what needs to implemented to provide an
extension for the corresponding type.

6.2 Writing an Instrumentation Extension

As explained in Section 6.1, for an extension we need an extension artifact class implementing
the functionality of the extension type and an extension class providing meta information on
the extension. Except for the class to inherit, the extension class has the same structure for the
extension types Instrumentation, Measurement and Load Generation (cf. Listing 6).

Listing 6: Extension class for an instrumentation extension

pub l i c c l a s s MyInstExtension extends Abstract Instrumentat ionExtens ion {

@Override
pub l i c S t r ing getName ( ) {

re turn ”MyInstrumentation ” ;
}

@Override
protec ted void i n i t i a l i z e C o n f i g u r a t i o n P a r a m e t e r s ( ) {

addConfigParameter (
Conf igParameterDescr ipt ion . c r ea t eExten s i onDesc r i p t i on (

”This t ex t prov ide s a d e s c r i p t i o n on the extens i on . ” ) ) ;

Conf igParameterDescr ipt ion aConfigParameter
= new Conf igParameterDescr ipt ion (

”parameterName ” , LpeSupportedTypes . Long ) ;
aConfigParameter . s e tDe fau l tVa lue ( 1 0 ) ;
aConfigParameter . s e t D e s c r i p t i o n (

”This t ex t d e s c r i b e s the c o n f i g u r a t i o n parameter . ” ) ;
addConfigParameter ( aConfigParameter ) ;

}

@Override
pub l i c boolean isRemoteExtension ( ) {

re turn true ;
}
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@Override
pub l i c boolean tes tConnect ion ( St r ing host , S t r ing port ) {

// t e s t connect ion to remote s a t e l l i t e
}

@Override
pub l i c I Instrumentat ionAdapter c r e a t e E x t e n s i o n A r t i f a c t ( ) {

re turn new MyInstExtens ionArt i fact ( t h i s ) ;
}

}

An instrumentation extension needs to inherit the class AbstractInstrumentationExtension.
getName returns the unique name of the extension. In the initializeConfigurationParameters

method we can provide a textual description of the extension as well as a set of extension-specific
configuration parameters. The isRemoteExtension method indicates whether the corresponding
extension is an adapter to a remote satellite. If that is the case, DynamicSpotter later uses
the testConnection method to check whether a connection to the remote satellite can be es-
tablished. Finally, the method createExtensionArtifact creates a new instance of the actual
instrumentation extension artifact (here: MyInstExtensionArtifact). In this example the class
MyInstExtensionArtifact implements the actual instrumentation adapter, and as such has to
inherit the class AbstractInstrumentationAdapter (cf. Listing 7).

Listing 7: Extension Artifact class for an instrumentation extension

pub l i c c l a s s MyInstExtens ionArt i fact
extends AbstractInstrumentat ionAdapter {

pub l i c MyInstExtens ionArt i fact ( IExtension<?> prov ide r ) {
super ( prov ide r ) ;

}

@Override
pub l i c void i n i t i a l i z e ( ) throws Instrumentat ionExcept ion {

// i n i t i a l i z a t i o n o f the ins t rumentat ion adapter
}

@Override
pub l i c void instrument ( Ins t rumentat i onDesc r ip t i on d e s c r i p t i o n )

throws Instrumentat ionExcept ion {
// instrument the t a r g e t a p p l i c a t i o n as s p e c i f i e d
// in the ins t rumentat ion d e s c r i p t i o n

}

@Override
pub l i c void uninstrument ( ) throws Instrumentat ionExcept ion {

// r e v e r t ins t rumentat ion
}

}

An instrumentation extension artifact has to implement three methods: initialize, instru-

ment and uninstrument. The initialize method takes care of conducting initialization tasks
required before the specific instrumentation tool can be used. The instrument method triggers
the instrumentation, realizing the instrumentation instructions wrapped by the instrumentation
description. Finally, the uninstrument method reverts the instrumentation. Depending on the tool
used for instrumentation the implementation of this instrumentation adapter may look completely
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different. For instance, if we are using our own instrumentation tool (Adaptable Instrumentation
and Monitoring (AIM)), the adapter just passes the instrumentation description to the remote AIM
instrumentation engine to realize the instrumentation. An instrumentation extension for Kieker
or DiSL would require to translate the instrumentation description into Kieker- or DiSL-specific
instrumentation instructions. Furthermore, if the instrumentation tool does not support dynamically
adaptable instrumentation, the instrumentation extension would need to take care of restarting
the target application to enable adaptation of the instrumentation state. Regardless of which
instrumentation tool is used behind an instrumentation extension, DynamicSpotter only assumes
that after calling the instrument method, the target application is instrumented accordingly.
Analogously for the uninstrument method.

6.3 Writing a Measurement Extension

A measurement extension class has to inherit the class AbstractMeasurmentExtension. Apart
from that, the extension class of a measurement extension has the same structure as shown in
Listing 6. A measurement extension artifact has to inherit the class AbstractMeasurmentAdapter
exhibiting a structure as depicted in Listing 8.

Listing 8: Extension Artifact class for a measurement extension

pub l i c c l a s s MyMeasurementExtensionArtifact
extends AbstractMeasurementAdapter {

pub l i c MyMeasurementExtensionArtifact ( IExtension<?> prov ide r ) {
super ( prov ide r ) ;

}

@Override
pub l i c void i n i t i a l i z e ( )

throws MeasurementException {
// i n i t i a l i z a t i o n

}

@Override
pub l i c void enableMonitor ing ( )

throws MeasurementException {
// a c t i v a t e data gather ing / r e s e t s p r e v i o u s l y gathered data

}

@Override
pub l i c void d i sab l eMon i to r ing ( )

throws MeasurementException {
// de a c t i va t e data gather ing

}

@Override
pub l i c MeasurementData getMeasurementData ( )

throws MeasurementException {
// c o l l e c t and return measured data

}

@Override
pub l i c void pipeToOutputStream ( OutputStream oStream )

throws MeasurementException {
// pipe measured data to the g iven oStream

}
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@Override
pub l i c long getCurrentTime ( ) {

// r e tu rn s the cur rent timestamp o f the
// node the measurement t o o l i s running on .
// This i s r equ i r ed f o r synchron i za t i on o f
// d i s t r i b u t e d measurement r e co rd s .

}
}

Analogously to the instrumentation adapter, a measurement adapter can be initialized. The
enableMonitoring and disableMonitoring activate data gathering on the target system. The
methods getMeasurementData and pipeToOutputStream allow to retrieve the data measured since
the last activation of monitoring. While getMeasurementData is a blocking call, pipeToOutput-
Stream allows to take advantage of data pipelining. Finally, getCurrentTime returns the current
timestamp of the monitoring tool. This timestamp is required to align the timestamps of all records
which may come from distributed system nodes. Analogously to instrumentation extensions, a
measurement extension serves as an adapter. For instance, if we want to use Kieker as monitoring
tool, the corresponding measurement extension has to take care of translating Kieker monitoring
records into the DynamicSpotter-specific representation of measurement data. In this way, we
enable the usage of diverse tools via the adapters while keeping a consistent data representation
within DynamicSpotter .

6.4 Writing a Load Generation Extension

A load generation extension class has to inherit the class AbstractWorkloadExtension. Apart
from that, the extension class of a measurement extension has the same structure as shown in
Listing 6. A load generation extension artifact has to inherit the class AbstractWorkloadAdapter
yielding a class structure as depicted in Listing 9.

Listing 9: Extension Artifact class for a load generation extension

pub l i c c l a s s MyWorkloadExtensionArtifact
extends AbstractWorkloadAdapter {

pub l i c MyWorkloadExtensionArtifact ( IExtens ion<?> prov ide r ) {
super ( prov ide r ) ;

}

@Override
pub l i c void i n i t i a l i z e ( )

throws WorkloadException {

// i n i t i a l i z a t i o n
}

@Override
pub l i c void startLoad ( LoadConfig loadConf ig )

throws WorkloadException {
// asynchronous ly s t a r t gene ra t i on o f workload

}

@Override
pub l i c void waitForWarmupPhaseTermination ( )

throws WorkloadException {
// b locks u n t i l the warm−up phase te rminate s

}
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@Override
pub l i c void waitForExperimentPhaseTermination ( )

throws WorkloadException {
// b locks u n t i l the s t a b l e experiment phase te rminates

}

@Override
pub l i c void waitForFinishedLoad ( ) throws WorkloadException {

// b locks u n t i l the coo l down phase te rminates
// and no load i s submitted to the t a r g e t a p p l i c a t i o n anymore

}
}

Same as for the instrumentation and measurement adapters, a workload adapter provides a method
for initialization tasks. By calling the startLoad method, DynamicSpotter tells a workload adapter
to start generating load asynchronously. The three wait___ methods block until the corresponding
experiment phase has been reached. In our extensions repository (cf. Section 7), we provide load
generation adapters for Apache JMeter, HP LoadRunner, and a simple custom workload generator
used in the Demo example in Section 4.3.

6.5 Writing a Detection Heuristic

In the DynamicSpotter framework the detection heuristics for individual performance problems are
managed as extensions, as well. The extension class of a detection heuristic extension has to extend
the class AbstractDetectionExtension. The three methods which need to be implemented we
already know from the general structure shown in Listing 3. The class implementing the actual
detection logic has to extend the AbstractDetectionController class. This inheritance requires
the detection class to implement four methods as shown in Listing 10.

Listing 10: Detection controller class for a detection heuristic extension

pub l i c c l a s s MyDetection extends Abs t rac tDetec t i onCont ro l l e r {

p r i v a t e i n t numExperimentSteps ;

pub l i c MyDetection ( IExtension<IDe t e c t i onCont ro l l e r> prov ide r ) {
super ( prov ide r ) ;

}

@Override
pub l i c void l o a d P r o p e r t i e s ( ) {

// load h e u r i s t i c−s p e c i f i c c o n f i g u r a t i o n p r o p e r t i e s
numExperimentSteps = I n t e g e r . pa r s e In t (

getProb lemDetect ionConf igurat ion ( ) .
getProperty ( ”myDetection . numSteps ” ) ) ;

}

@Override
protec ted void executeExperiments ( )

throws Instrumentat ionExcept ion , MeasurementException ,
WorkloadException {

// c r e a t e a problem s p e c i f i c ins t rumentat ion d e s c r i p t i o n
Ins t rumentat i onDesc r ip t i on in s tDes c r = . . . ;
// t r i g g e r d e f a u l t experiment s e r i e s
executeDe fau l tExper imentSer i e s ( MyDetection . c l a s s ,

numExperimentSteps , i n s tDesc r ) ;
}
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@Override
protec ted Spot te rResu l t ana lyze ( Data s e tCo l l e c t i on data ) {

// ana lyze measurement data
// . . .
Spot te rResu l t r e s u l t = new Spotte rResu l t ( ) ;
r e s u l t . s e tDetected ( t rue ) ;
r e s u l t . addMessage ( ”Detect ion run f i n i s h e d s u c c e s s f u l l y ! ” ) ;
r e turn r e s u l t ;

}

@Override
pub l i c long getExper imentSer iesDurat ion ( ) {

// es t imate durat ion o f the experiment s e r i e s to execute
}

}

The loadProperties method is called by DynamicSpotter directly after the instantiation of the
detection class. This method can be used to load heuristic-specific properties as defined in the
getConfigParameters method of the extension class (cf. Listing 3). The detection process of an
individual heuristic comprises two phases: an experiment execution phase and an data analysis
phase. While the former is triggered by the executeExperiments method, the analyze method is
responsible for analysing the measured data and return a detection result. For the experiment phase,
a detection heuristic has to specify a problem-specific instrumentation of the target application
by providing an instrumentation description. (Note: this instrumentation description should be
system independent in order to be reused in other systems as well.) Using the instrumentation
description the detection heuristic can tell the DynamicSpotter to execute a series of experiments
(cf. executeDefaultExperimentSeries) using the corresponding instrumentation, measurement
and load generation adapters. defaultExperimentSeries means that a set of n experiments is
executed, whereby the load is increased from one experiment to the next between a load of 1
user and the specified maximum number of users. When the experimentation phase has finished,
DynamicSpotter calls the analyze method passing the measured data as input to that method. It is
now up to the analyze method to apply certain detection rules in order to provide a detection result.
A detection result has to state whether the corresponding analyzed performance problem has been
detected or not. Finally, the getExperimentSeriesDuration method is used by DynamicSpotter
to estimate the duration of the experiments. In this method, the developer of a detection heuristic
has to provide the estimated duration (in seconds) of the experiments executed for that heuristic.

27



7 Useful Links

Link & Description

Code Repositories

https://github.com/sopeco/DynamicSpotter/tree/ver-1.0.0

DynamicSpotter framework repository

https://github.com/sopeco/DynamicSpotter-Extensions

Extensions repository for DynamicSpotter

https://github.com/sopeco/LPE-Common

Repository containing utility libraries for performance measurements, data analysis, load gener-
ation, etc.

Documentation

http://sopeco.github.io/DynamicSpotter

Documentation on DynamicSpotter

https://github.com/sopeco/DynamicSpotter-Demo/releases/download/v1.0/demo-all-in-one.zip

https://github.com/sopeco/DynamicSpotter-Demo/releases/download/v1.0/demo-all-in-one.tar.gz

All-in-One Drop (as .zip or .tar.gz file) containing the demo example for DynamicSpotter

Table 2: Useful Links
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